Epson Stylus® NX100 Series

Quick Guide

Basic Copying, Printing, and Scanning
Maintaining Your NX100 Series
Solving Problems
# Contents

**Introduction** ................................................................. 3

**Loading Paper** ............................................................... 4
   Using Special Papers ..................................................... 5

**Copying a Document or Photo** .............................................. 7
   Placing the Original on the Glass ....................................... 7
   Copying a Document ....................................................... 8
   Copying a Photo ............................................................ 9
   Copying Draft Documents ................................................ 10

**Printing From Your Computer** .............................................. 11
   Printing in Windows ...................................................... 11
   Printing With a Macintosh ............................................... 13
   Selecting the Correct Paper Type ..................................... 17

**Scanning a Photo or Document** ............................................ 18
   Basic Scanning ............................................................ 18
   Restoring and Correcting Photos ...................................... 19

**Maintaining Your NX100 Series** .......................................... 20
   Checking the Print Head Nozzles ....................................... 20
   Cleaning the Print Head ................................................ 21
   Checking the Ink Cartridge Status .................................... 22
   Replacing Ink Cartridges ............................................... 23

**Solving Problems** ............................................................ 28
   Checking for Software Updates ........................................ 28
   Error Indicators ........................................................... 28
   Problems and Solutions ................................................ 29
   Where To Get Help ........................................................ 31

**Notices** ............................................................................. 33
Introduction

After you have set up your Epson Stylus® NX100 Series as described on the Start Here sheet, turn here to:

- Load paper
- Make a copy of a document or photo
- Get the basic steps for printing from your computer
- Scan a document or photo and restore or correct the color, if necessary
- Perform routine maintenance
- Solve simple problems

This book tells you how to do most of these things without ever turning on your computer! Of course, your NX100 Series can do a lot more when you connect it to your Windows® or Macintosh® computer. For additional instructions, see the on-screen Epson Information Center by double-clicking the icon for it on your desktop.

Please follow these guidelines as you read your NX100 Series instructions:

**Warning:**
Warnings must be followed carefully to avoid bodily injury.

**Caution:**
Cautions must be observed to avoid damage to your equipment.

**Note:**
Notes contain important information about your NX100 Series.

**Tip:**
Tips contain hints for better copying, scanning, and printing.
Loading Paper

You can print on a variety of paper types and sizes. For details, see page 5.

1. Open the paper support, then open the output tray and pull out the extension.

2. Flip the clear plastic feeder guard forward, then squeeze the edge guide and slide it left.

3. Insert paper, glossy or printable side up, short edge first, against the right side and beneath the tab. (Load letterhead or pre-printed paper top edge first.)

Always load paper short edge first, even for landscape printing.
You can load up to 80 sheets of plain paper, Epson Bright White Paper, or Presentation Paper Matte, or 20 sheets of photo paper. Load other special papers one sheet at a time.

**Note:**
The type of paper you choose affects the way your printout looks. If you are just making a copy or printing a rough draft, plain paper is fine. However, for the best results, you'll want to use one of Epson’s special ink jet papers designed for your printer. See the next section for more information.

4. Slide the edge guide against the paper, but not too tightly.

5. Flip the clear plastic feeder guard back.

**Note:**
For instructions on loading envelopes, see your on-screen Epson Information Center.

---

### Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central™ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) or visit Epson’s website.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 in.</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 in.</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 in.</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 in.</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 in.</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 in.</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 in.</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Borderless 4 × 6 in.</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 in.)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 in.</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive sheets</td>
<td>A4 (8.3 × 11.7 in.)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Copying a Document or Photo

Follow the instructions in this section to position your originals correctly on the glass and make color or black-and-white copies.

Placing the Original on the Glass

1. Open the document cover and place your original face-down on the glass, with the top facing into the front right corner.

2. Close the cover gently so you don't move the original.
Copying a Document

You can copy documents onto letter- or A4-size plain paper or Epson special paper just like a copy machine.

1. Load letter- or A4-size plain paper or Epson special paper.

2. Place your original document on the document table.

3. Press the ◊ B&W Text button (for black-and-white documents) or ◊ Color Text button (for color documents) to start copying.

If you want to enlarge your document to fit on letter- or A4-size paper, press and hold either the ◊ B&W Text button (for black-and-white documents) or ◊ Color Text button (for color documents) for three seconds.

If you need to cancel copying, press the ◊ Stop button.

Note:
Copies may not be exactly the same size as your original document.
Copying a Photo

You can copy photos onto 4 × 6-inch Epson photo paper (various types available) for borderless photo reprints.

1. Load up to 20 sheets of 4 × 6-inch Epson photo paper.
2. Place your original photo on the document table.
3. Press the Color Photo button to start copying. The NX100 Series automatically sizes your photo to fit on the paper you loaded.

If you need to cancel copying, press the Stop button.

Note:
Copies may not be exactly the same size as your original photo, and cropping may occur at the edges.
Copying Draft Documents

You can make quick draft copies of documents on plain paper or Epson Bright White paper. Draft copies have reduced print quality, but they print faster.

1. Load letter- or A4-size plain paper or Epson Bright White paper.
2. Place your original document on the document table.
3. Press and hold the Stop button as you press either the B&W Text button (for black-and-white documents) or Color Text button (for color documents).

If you need to cancel copying, press the Stop button.

Note:
Copies may not be exactly the same size as your originals.
Printing From Your Computer

This section describes the basic steps for printing a photo or document stored on your Windows or Macintosh computer. For detailed instructions on printing, see the on-screen Epson Information Center.

Before you start, make sure you've installed your printer software and connected the NX100 Series to your computer as described on the Start Here sheet.

Tip:
It’s a good idea to check for updates to your NX100 Series software (see page 28 for instructions).

Printing in Windows

1. Open a photo or document in an application.
2. Open the File menu and select Print. You see a window like this one:

   ![Print dialog box]

   Select your printer

   Click here to open your printer software

3. Make sure EPSON NX100 Series is selected, then click the Preferences or Properties button.

   (If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.)
4. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 17 for details).

**Tip:**
For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab. For details, see your on-screen Epson Information Center.

5. To improve the color, contrast, and sharpness of photos, select Fix Photo.

6. To reduce or remove red-eye effects in photos, select Fix Red-Eye.

7. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

8. For more printing options, click the Advanced tab.

**Note:**
For more information about print settings, click Help or see your on-screen Epson Information Center.

9. Click OK to save your settings.
10. Click OK or Print to start printing. This window appears and shows the progress of your print job.

**Printing With a Macintosh**

See one of the sections below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select EPSON Stylus NX100 as the Printer setting.
4. Click ▼ to expand the Print window, if necessary.
5. Select the basic page setup options. For borderless photos, choose a Paper Size setting with a Sheet Feeder - Borderless option.

**Note:**
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing.

6. Choose Print Settings from the pop-up menu, then select the following settings that appear on the bottom of the screen:

7. Choose any other printing options you may need from the pop-up menu. See the on-screen Epson Information Center for details.

**Tip:**
To reduce or remove red-eye effects in photos, choose Extension Settings from the pop-up menu and select Fix Red-Eye.

8. Click Print.
9. To monitor your print job, click the printer icon in the dock. Select your print job, then select an option to cancel, pause, or resume printing, if necessary.

Mac OS X 10.3 to 10.4

1. Open a photo or document in an application.
2. Select Page Setup from the File menu. Select the following settings:

   - For borderless printing, choose a Sheet Feeder - Borderless option in the Paper Size list for your paper size.
3. Click OK to close the Page Setup window.
4. Select Print from the File menu. You see a window like this one:

![Print window](image)

- Select your printer
- Select Print Settings

5. Choose **Print Settings** from the pop-up menu and select the following settings as necessary:

![Print settings window](image)

- Select your paper type (see page 17)
- Select Color or Black Ink Only
- Select higher quality or faster printing (if available)
- Select Automatic mode

**Note:**
In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

6. Click the **Advanced** button to change additional settings.

**Note:**
For more information on advanced settings click ?.

7. Choose any other printing options you may need from the pop-up menu. See your on-screen Epson Information Center for details.

8. Click **Print**.
9. To monitor the progress of your print job, click the printer icon in the dock (or click the Print Center icon and double-click Stylus NX100 on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 12) or Media Type (see page 14 or page 16) setting in your printer software. This tells the NX100 Series what kind of paper you're using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

Selecting the Correct Paper Type 17
Scanning a Photo or Document

You can use your NX100 Series to scan a photo or document and save it on your computer or other device.

You can even restore and correct photographs as you scan (see page 19).

The Epson Scan software provides three scanning modes:

- **Full Auto Mode** scans quickly and easily using automatic settings.
- **Home Mode** previews your image and provides preset options for scanning.
- **Professional Mode** previews your image and provides a full array of tools.

**Note:**
For detailed scanning instructions, see your on-screen *Epson Information Center*.

---

**Basic Scanning**

You can scan from any TWAIN-compliant application using Epson Scan. Or you can start Epson Scan directly from your computer and save your image to a file.

1. Open the document cover and place your original face-down on the glass, in the front right corner, as shown on page 7.
2. Close the cover gently so you don't move the original.
3. Do one of the following to start Epson Scan:
   - **Windows:** Double-click the **EPSON Scan** icon on your desktop.
   - **Macintosh:** Double-click **EPSON Scan** in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose **Import** or **Acquire**, and select **Epson Stylus NX100 Series**.
You see the Epson Scan standby window:

4. If the Mode setting in the upper right corner is set to Full Auto Mode, click the Scan button.
   
   If you are in Home or Professional Mode, you see a different Epson Scan settings window. (You can change the mode using the Mode selector in the upper right corner.)

5. If you want to restore faded color in a photo or make other corrections, click Customize. Then follow the instructions below.

6. Click OK. The image is scanned and you see its icon in Windows Explorer or Macintosh Finder.

**Restoring and Correcting Photos**

You can automatically transform a faded, dusty, or badly exposed color photo into one with true-to-life color and sharpness as you scan. Use the Color Restoration and Dust Removal options in Epson Scan’s Full Auto Mode. In Home and Professional Mode, you can also select Backlight Correction to remove shadows from images with too much background light.

**Full Auto Mode**

Click the Customize button, click Dust Removal and/or Color Restoration, click OK, and click Scan.

Select Auto Photo Orientation to orient your photos based on detected faces, the sky, etc. If your photo is not oriented correctly, turn it off.

**Note:**
For more information, see your on-screen Epson Information Center. You can also click Help on the Epson Scan screen for information about all the available settings.
Maintaining Your NX100 Series

Follow the instructions in this chapter for checking and cleaning the print head nozzles and replacing ink cartridges. To align the print head, if necessary, see your on-screen Epson Information Center.

Caution:
To keep your NX100 Series looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Load letter-size paper in the sheet feeder.
2. Turn off the NX100 Series.
3. Hold down the \textit{Stop} button as you press the \textit{On} button to turn the NX100 Series back on. Hold down both buttons until the \textit{On} light begins to flash, then release the buttons.
4. Check the nozzle check pattern that prints to see if there are gaps in the lines.

![Nozzles are clean](image1.png) ![Nozzles need cleaning](image2.png)

5. If there are no gaps, the print head is clean. If there are gaps or the pattern is faint, clean the print head as described in the next section.

---

**Cleaning the Print Head**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
You cannot clean the print head if an ink cartridge is expended, and you may not be able to clean it when a cartridge is low. You must replace the cartridge first (see page 23).

1. Make sure the NX100 Series is on and the Ink light is off.
2. Hold down the Stop button for three seconds to start the cleaning cycle, which lasts around one minute.

**Caution:**
Never turn off the NX100 Series during head cleaning or you may damage it.

3. When the On light stops flashing, run a nozzle check (as described on page 20) to verify that the print head is clean.
4. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

**Note:**
If you don’t see any improvement after cleaning the print head two times, turn off your NX100 Series and wait at least six hours to let any dried ink soften. Then try cleaning the print head again. If quality does not improve, one of the ink cartridges may need to be replaced. If that doesn’t help, contact Epson as described on page 31.

If you do not use your NX100 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

When the ink light starts flashing, a cartridge is low on ink. You can continue printing until a cartridge needs replacement. When the ink light stays on, you need to replace a cartridge.

Note:
You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing or copying.

A window may also appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates retrieved from an Epson website. On a computer that is connected to the Internet, you may see a screen asking if you want to receive these Epson offers the first time you try to print when ink is low. Click Accept or Decline.

Note:
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen Epson Information Center.

Tip:
If a cartridge is more than six months old, print quality may decline. If necessary, try cleaning the print head (see page 21). If printouts still do not look their best, you may need to replace the cartridge.

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Moderate capacity</th>
<th>Standard capacity (for heavier use)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>88</td>
<td>69</td>
</tr>
<tr>
<td>Cyan</td>
<td>88</td>
<td>69</td>
</tr>
<tr>
<td>Magenta</td>
<td>88</td>
<td>69</td>
</tr>
<tr>
<td>Yellow</td>
<td>88</td>
<td>69</td>
</tr>
</tbody>
</table>
Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

The printer ships with full cartridges and part of the ink from this first set of cartridges is used for priming the printer.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold temperatures, allow them to warm up to room temperature for at least 3 hours before using them.

Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Note:
Leave the expended cartridge installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

1. Turn on the NX100 Series.

Note:
If you need to change a cartridge before it is expended (the ink light is flashing or off), run the ink cartridge replacement utility. See the on-screen Epson Information Center for details.
2. Open the scanner and prop it up with its support.

![Image of scanner being opened]

**Caution:**
Do not touch the white cable inside the printer or you may damage it.

3. Press the  Stop button. The print head moves to the position to indicate which cartridge is low or expended.

![Image of print head moving]

**Caution:**
Do not move the print head by hand; this may damage your NX100 Series. Always press the  Stop button to move it.

4. Press the  Stop button again.

- If another cartridge is low or expended, it moves to the position. Press the  Stop button again to see if any more cartridges are low or expended.

- If no other cartridges are low or expended, the print head moves to the replacement position.
5. Squeeze the tab on the cartridge and lift it up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

**Caution:**
Do not touch the white cable inside the printer or you may damage it.

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

6. Before you open the new cartridge package, shake it four or five times. Then remove it from the package.

**Caution:**
Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.
7. Remove the yellow tape from the bottom of the ink cartridge.

Caution:
Do not remove any other labels or seals, or ink may leak.

8. Insert the new ink cartridge into the holder and push it down until it clicks into place.

9. Once you replace all the cartridges that need replacing, lift the scanner slightly, release its support, and lower the scanner.
10. Press the ☹ Stop button to begin charging the ink. This takes about 1 1/2 minutes. When it’s finished, the ☻ On light stops flashing and remains on, and the ⚦ ink light goes out.

   **Caution:**
   Never turn off the NX100 Series while ink is charging or you’ll waste ink. If the ⚦ ink light flashes, press the ☹ Stop button and press down all the cartridges securely.

   **Note:**
   If you replaced a cartridge while copying a document or photo, cancel printing and make sure your original is still placed correctly on the document table. Then copy your original again.

   If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
Solving Problems

If you have a problem with your NX100 Series, check the lights on the control panel to diagnose the cause.

You can also check “Problems and Solutions” on page 29 for basic troubleshooting suggestions, or double-click the Epson Information Center icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your Epson Stylus NX100 Series software. Open your on-screen Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click or Start, select All Programs or Programs, select EPSON, select EPSON NX100 Series, and click Driver Update.

Error Indicators

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>On light slowly flashing</td>
<td>The NX100 Series is in sleep mode. Press any button except the On button to wake it up.</td>
</tr>
<tr>
<td>paper light on</td>
<td>Paper is out or multiple pages have fed. Load or reload paper in the sheet feeder.</td>
</tr>
<tr>
<td>paper and On light flashing at same rate</td>
<td>Paper is jammed. Carefully remove the jam, as described on page 30.</td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you're having trouble using your NX100 Series.

Printing and Copying Problems

■ Make sure your original is positioned in the front right corner of the glass. If the edges are cropped, move your original away from the edges slightly.

■ Make sure your paper is loaded short edge first and is positioned against the right side with the edge guide against its left side. Don't load paper above the arrow mark inside the edge guide.

■ Make sure the paper size settings are correct for the paper you loaded.

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>♦ ink light flashing</td>
<td>One or more cartridges have low ink. You can continue printing until a cartridge needs replacement. Check the cartridge status to determine which cartridges are affected (see page 22).</td>
</tr>
<tr>
<td>♦ ink light on</td>
<td>One or more ink cartridges are expended, incorrectly installed, or cannot be used with the printer. If an ink cartridge is likely to be expended, you must replace the cartridge to be able to print. If you just replaced a cartridge and the light is still on, the cartridge is not installed correctly. Press the Stop button to move the cartridges to the replacement position. Press down on all the installed cartridges, then press the Stop button to continue.</td>
</tr>
<tr>
<td>All lights are on</td>
<td>Parts inside the NX100 Series are at the end of their service life. Contact Epson for help (see page 31).</td>
</tr>
<tr>
<td>All lights are flashing</td>
<td>There is a problem with the NX100 Series. Turn it off, wait a few moments, and turn it back on again. If the error is not resolved, contact Epson for help (see page 31).</td>
</tr>
</tbody>
</table>
Paper Feeding Problems

- If paper doesn’t feed, remove it from the sheet feeder. Flip through the stack to separate the sheets a little. Then reload the paper against the right side, and slide the left edge guide against the paper (but not too tightly).

- Do not load too many sheets at once. Load up to 20 sheets of photo paper, or 80 sheets of plain paper, Epson Bright White Paper, or Presentation Paper Matte. Load other special papers one sheet at a time.

- Do not load paper with holes punched in it.

- If paper is jammed, follow these steps:
  1. Gently pull out jammed paper from the output tray or sheet feeder.
  2. If paper is stuck inside, turn off the NX100 Series.
  3. Lift the scanner, check everywhere for jammed paper and torn pieces, remove them, lower the scanner, and turn the NX100 Series back on.

Print Quality Problems

If you have any problems with the copy or print quality, try these solutions:

- Make sure the document is placed flat against the document table glass and the NX100 Series is not tilted or placed on an uneven surface.

- Load the paper printable side up (usually the whiter, brighter, or glossy side).

- Make sure your paper isn’t damp or curled.

- Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.

- Make sure the type of paper you loaded matches the paper size and paper type settings in your printer software (see page 17).

- For the best print quality, use Epson special paper (see page 5) and genuine Epson ink cartridges (see page 22).

- If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head (see page 21). This unclogs the nozzles so they can deliver ink properly. Run a nozzle check (see page 20) to see if the print head needs cleaning.

- Clean the print head as described on page 21.
If you notice jagged vertical lines, you may need to align the print head. See your Epson Information Center for instructions.

The ink cartridges may be low on ink. Check your cartridge status (see page 22) and replace cartridges, if necessary (see page 23).

If a dotted line appears in the image, clean the document table glass with a soft, dry, lint-free cloth (paper towels are not recommended and may permanently scratch the surface), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.

---

**Where To Get Help**

**Epson Technical Support**

**Internet Support**

Visit Epson’s support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

**Speak to a Support Representative**

Before you call Epson for support, please have the following information ready:

- Product name (Epson Stylus NX100 Series)
- Product serial number (located on the label in back)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:

- U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.
Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

**Purchase Supplies and Accessories**

You can purchase genuine Epson ink and paper at Epson Supplies Central at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Important Safety Instructions

Before using your NX100 Series, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the NX100 Series.
■ Use only the type of power source indicated on the NX100 Series label.
■ Use only the power cord that comes with the NX100 Series. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the NX100 Series near a wall outlet where the plug can be easily unplugged.
■ If you won’t be using the NX100 Series for a long period, unplug the power cord from the electrical outlet.
■ Always turn off the NX100 Series using the On button, and wait until the On light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
■ Avoid plugging the NX100 Series into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the NX100 Series, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the NX100 Series for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
■ Do not place or store the NX100 Series near a radiator or heating vent, in a dusty or moist environment, in direct sunlight, or outdoors.
■ Keep the away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
■ Do not use aerosol products that contain flammable gases inside or around the NX100 Series. Doing so may cause fire.
■ Place the NX100 Series on a flat, stable surface that extends beyond its base in all
directions. It will not operate properly if it is tilted or at an angle.
■ Do not open the scanner section while the NX100 Series is copying, printing, or
scanning.
■ Do not touch the flat white cable inside the NX100 Series, and be careful not to trap
your fingers when closing the scanner.
■ Do not spill liquid on the NX100 Series or use it with wet hands.
■ Except as specifically explained in your documentation, do not disassembly, modify,
or attempt to service the NX100 Series yourself.
■ Unplug the NX100 Series and refer servicing to qualified service personnel under the
following conditions: if the power cord or plug is damaged; if liquid has entered the
product; if the product has been dropped or the case damaged; if the product does not
operate normally or exhibits a distinct change in performance. Adjust only those
controls that are covered by the operating instructions.
■ When storing or transporting the NX100 Series, do not tilt it, stand it on its side, or
turn it upside down; otherwise ink may leak from the cartridges.

**Ink Cartridge Safety**

■ Keep ink cartridges out of the reach of children and do not drink the ink.
■ Be careful when you handle used ink cartridges; there may be ink remaining around
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets
in your eyes, flush them immediately with water.
■ Do not put your hand inside the NX100 Series or touch any cartridges during
printing.
■ Install a new ink cartridge immediately after removing an expended one. Leaving
cartridges uninstalled can dry out the print head and may prevent the NX100 Series
from printing.
■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and
dust and store it in the same environment as the NX100 Series. Note that there is a
valve in the ink supply port, making covers or plugs unnecessary, but care is needed to
prevent the ink from staining items that the cartridge touches. Do not touch the ink
cartridge ink supply port or surrounding area. Store cartridges with their labels facing
upward.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C411A
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson Connection at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction...
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:

To find the Epson Customer Care Center nearest you, visit:
http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Epson Stylus are registered trademarks, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2008 Epson America, Inc. 5/08